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1 Scope

This document describes the following:

- Using Gravity 64-bit Analyzer card with GRAVity FCAV Analyzer Application Software

This document provides a high level description of the hardware, but does not include

register definitions and details for controlling the card.

1.1 Customer Specific Firmware

It is intended that the Gravity FCAV card support customer specific FC-AV and ARINC818

implementations. These implementations may cover less common image sizes, pixel
packing methods, header definitions, and/or compression methods.

For customers using

special firmware loads, Great River will assign a unique, customer specific part number.
Additional details for a customer specific FC-AV and ARINC818 protocol will be covered in a

customer specific ICD.

1.2 Reference Documents

ANSI X3.230-1994

ANSI X3.297-1997

ANSI X3.303-1998

ANSI INCITS 356-2002

ARINC 818 Draft 1

Fibre Channel - Physical and Signaling Interface
(FC-PH)

Fibre Channel — Physical and Signaling Interface — 2
(FC-PH-2)

Fibre Channel - Physical and Signaling Interface - 3
(FC-PH-3)

Fibre Channel — Audio Video (FC-AV), 25 November
2002

Avionics Digital Video Interface, High Data Rate,
Dec. 24, 2005
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2 Overview of Gravity FCAV Analyzer

2.1 Product Description

The Gravity FCAV Analyzer product is intended to support implementations of ANSI INCITS
356-2002 Fibre Channel — Audio Video (FC-AV) for transporting digital video, in particular,
the ARINC818 implementations.

The FCAV Analyzer captures 16Mbytes of raw data from the FC link, including all special
characters and idles. For an XGA signal at 60 Hz, this represents approximately 3.5 FC
containers of video frames. The analyzer provides a byte-by-byte look at each FC frame.
The software facilitates data capture by providing a variety of trigging options. Once data is
captured, it is color coded and labeled according to FC Frame numbers. A search feature
facilitates finding errors, ordered sets, or strings of data. Timing information is provided for
FCAV containers, FC Frames, video lines and frames

Fibre Channel provides a reliable, high bandwidth video link for video networks, pointto-point
video connections (up to 500 meters using multi mode fiber and up to 10km using single
mode fiber).

Each Gravity FC-AV card is Fibre Channel compliant at the FC-0, FC-1, and FC-2 layers. The
cards use Frame Header Control Protocol (FHCP) and described in Clause 7 of the FCAV
standard. FHCP is an easy to implement, low overhead, protocol based on the FC-AV
container system. FC-AV containers are described in Clause 5 of the FC-AV standard.

The cards are currently available at 2.125Gbps link speed. Customers can special order
other link speeds between 1 and 3.1875 Gbps.

Gravity64 FC-AV is a 64/66 PCI card that can achieve 160Mbytes/sec transfer rates.

The following sections describe the cards compatibility with Fibre Channel Standards when
using the standard firmware load.

2.2 Fibre Channel Compatibility

The Gravity FC-AV cards are Fibre Channel compatible at the FC-0, FC-1, and FC-2 as
described below.

2.2.1 Compatibility with FC-0, FC-1, FC-2
2.2.1.1 Physical

Gravity FC-AV card can be configured with either optical or copper interfaces (or both).

All cards can be factory loaded with SFF Transceivers that operate at 850 nm or 1310 nm.
These transceivers are compatible with standard LC multimode or single mode fiber cable.

Lower baud rate’(<1.5Gbps) cards can also be factory loaded with high-speed transformer

coupled electrical interfaces. The copper interfaces uses two "differential 1x3" shrouded
connectors compatible with 150-Ohm FCN1010 type cable.
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See the Product Specification sheet for ordering options.

2.2.1.2 Signaling/Encoding

All cards use 8B/10B Encoding (per ANSI X3.230-1994 -FC-PH) for all signaling
transmission.

2.2.1.3 Signaling Speed

Standard signaling speed is 2.125 Gbps. Non-standard baud rates can also be achieved
through special factory loaded oscillators.

2.2.1.4 Fibre Channel Frames and Ordered sets

All cards use Fibre Channel Frames and Ordered sets as defined in ANSI X3.230-1994 (FC-
PH)

2.2.2 Compatibility with the FC-AV Standard

When using Great River’s standard firmware along with the EFC_FCAV application software,
the Gravity FC-AV cards transport digital video using Frame Header Control Protocol (FHCP)
as described in the FC-AV Standard Clause 7.

More specifically, Gravity FC-AV cards use FHCP to transport FC-AV Containers (FC-AV
Standard Clause 5), where a single Video frame is loaded into a single simple mode
container.

2.2.3 Compatibility with other FC equipment

Gravity FC-AV cards use FC frames as the basic unit of transport for video and header data.
FC frames are further discussed in the referenced FC-PH specification. As such, the digital
video link will be compatible with commercial off-the-shelf Fibre Channel development tools.
FC-AV is not compatible with other data oriented protocols used with Fibre Channel such as
SCSI or RDMA.

2.2.4 Non-standard implementations

Gravity FCAV cards supports customer specific FC-AV implementations through special
firmware loads. These implementations may cover less common image sizes, pixel packing
methods, header definitions, and/or compression methods. These implementations may
deviate from FC standards in order to meet the need of proprietary video interfaces.

2.3 ARINC 818 Compatibility

The GRAVity FCAV Analyzer was designed with ARINC 818 compatibility in mind, and the
ARINC 818 Draft 1 Avionics Digital Video Interface, High Data Rate, Dec. 24, 2005, was
consulted. However, since ARINC 818 is still in draft form, the GRAVity FCAV analyzer is
not guaranteed to be compatible with the emerging standard. Once the standard is finalized,
a GRAVity ARINC 818 Analyzer will be developed for specific implementations of ARINC
818.
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3 Gravity FC-AV Hardware Operation

Voltage Regulators

) _ Power Valid LED’s
SOFI/EOFt FPGA Config

TXON RXON  Detect done/valid +2.5 RocketlO

~ +5V

~ +1.5V Core

" +2.5

" +3.3V

3.0.2 Circuit Card LED Indicators
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Copper FCN
Receiver

Copper FCN
Transmitter

(Ioop-through)\

Fibre Optic

Transmitter
(Ioop-through)\‘

Fibre Optic/

Receiver

igure 3.0.3 Circuit Card Front Panel I/O Connectors

Sync Conn
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Configuration PROM
Programming Cable Port

Mezzanine Expansion
(not used)

anNL 50 ey @
e, 0443 =
MALIE LM R AG

LA I TR

I Susmysale CA S4030

Figure 3.0.4 Circuit Card I/O Connectors
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3.1 Recommended System Configuration

The FCAV hardware manages the majority of the tasks needed to receive and analyze FCAV
signals.

Minimum System Requirements:

Processor: Pl 733MHz

Memory: 128MB

BUS: 533MHz FSB w/ (1) PCI slot or (1) PCI-X slot
Video Card: 64 MB (capable of 1280x1024 resolution)

Recommended System Requirements:

Processor: P4 3.0GHz

Memory: 512MB

BUS: 800MHz FSB w/ (1) PCI slot and (1) PCI-X slot
Video Card: ATl or NVIDIA w/ 256 MB

Data capture is accomplished by the FCAV hardware. FCAV hardware will process video
images from FC link. System performance will impact the response time of the application,
and time to transfer images from hardware memory to PC memory. The maximum bandwidth
for the PCI 64bit/66Mhz bus is 528MBps. The maximum bandwidth for the PCI 32bit/33Mhz
bus is 132MBps. The FCAV hardware typically achieves a bandwidth of 160MBps in a PCI
64bit/66Mhz. This is sufficient to support FCAV applications from 1.0625Gbps or 2.125Ghps
link speeds. Operating the FCAV Analyzer card in a 32-bit slot will not impact the analyzer
capture performance, but may slow down the transfer of data from the hardware to the
software.

3.2 Memory Operation

The hardware has two 2MB by 32-bit memory spaces referred to as Ping and Pong memory.
The memory is single port SDRAM. These memory spaces are used for several tasks. The
memory is used to store trace data from the FC link and move data from PC memory via the
PCI bus.

3.3 PCl Interface

The Gravity64 FC-AV cards have 64-bit PCI interfaces that run at 66 MHz which drive +3.3
volt logic levels on outputs and have +5 volt tolerant inputs.
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3.4 Fiber and Copper Interface

When a data capture is triggered, the GRAVITY FC-AV Analyzer card captures raw FC data
via a FO850 link or a standard FCN copper interface and stores the data in on-board

memory, and then transfers the data via a DMA transfer over the PCI bus as depicted in
Figure 3.4 below.

{ Video Stream
= m=——=(""1 Viideo Stream

Figure 3.4 Data Capture
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4 Using the GRAVity FC-AV / ARINC818 Analyzer

4.1 Hardware and Software Installation

First, follow the instructions in the Quick Start Guide for GRAVity FCAV. This covers board
installation and loading the driver.

Once the board and driver are installed, insert the GRAVity FCAV Analyzer set-up disk. The disk
should auto launch and guide you through the installation steps, click next at each dialog box. If

the disk does not auto launch, then using Windows Explorer, find the setup.exe file on the CD,
and double click it to launch the installation.

4.2 System Memory Allocation

The FCAV Analyzer software allocates buffers in system memory to store data. The
application uses approx 60 Mbytes.
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4.3 Capturing and Analyzing Data

4.3.1 Quick Start

The fastest way to capture data is to :

1. Hook your Optic or Copper cable to the analyzer ports. Select either Optic
(default) or copper in the Source selection
Source
QO Dptic
® Copper
2. Load a Profile for your FCAV or ARINC818 format.
Select the Load Profile menu item from the File menu.
k2| GRAVity Analyzd
FIEN Advanced Help
I Load Profil
Select Prafike
Lok [ 3 PRFLES SR i
3 :IENHC«!IIT’.DA": __:Im_qs_-n:it
S e
Deamcra A| mesi_ehat. povidls 1t guralie
r",,’i ] wxsd_get | ol 1] rechamcn poc i
bt Tlerm oo ok 3 R
Dbt g o, e
|k e
1y S il
b e 1] Fexe prafile
4] bamrdeparc s
§ e
= ! i
Mobmmie. {3 earore
lrf'g# Fi [ [l [Ien
Fleon'npe Frokisc |”. FRLF Lz - Carcal |
3. Click start to trigger for a capture
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4.3.2 Graphical User Interface Overview

The ARINC818/FCAV Analyzer Application is shown below with each of the major
sections labeled.

S GRAN I A ks Whew ok (GRARTTIOES FCRY Drim inalymen) Mer 3,50
s B

rSauch bum Wuk -

e [aln Vs

W FFreme & T ot mccack mivam B30

T i [ e e e L R

1 Lishe e
Limd 0 N1k
LT A1

105170

L1

L

Lo

L0E17In

10171

LLL Tl B

171

L1714

1E7LE

LG

LOS1TLT

L0171

K™

101730

e Tosd bmr o wamece, 001 g e Lioed = 245

Flgure 4.3.1 GRAVity FCAV Analyzer Graphical User Interface (GUI)

Area for setting data capture triggers: predefined or user defined.

Data capture button to initiate a new data trace.

Link Status indicates the health of the FC link.

Raw Data window, displays captured data with time stamp and colored decoding.
Histogram — graphically represents total data size and current frame being viewed.
FCAV container related information and statistics.

FC Frame related information and statistics.

Video frame and line timing information and statistics.

Search feature with predefined and user defined options.

10 Configuration information indicates FCAV profile loaded, API version, and FPGA version.
11. Input Source, either Optic or Copper.

12. Container Tabs, Header and Image can be viewed.

CoNOORA~LONE
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4.3.3 Loading a Profile

A default profile will be loaded automatically. To select a different profile, in the File menu, select
Load Profile. The profile will not need to be changed once it has been set-up for the proper frame
size and frame rate. Tolerance values may need to be adjusted if receiving variable frame rates
since the min and max values may be exceeded causing status flags to indicate RED meaning
out of range, the line and container min/max values are highlighted in the example of a profile
shown below.

#RATE

DATARATE,2.125

#VALUES
LINETIMEMINMAX,20.45,20.9
CONTAINERRATEMINMAX,16.6,16.7
VIDEORESOLUTION,1024,768
BYTESPERPIXEL,3
FRAMESPERLINE,?2 i Deikiee
#SIZES - a.
CONTINERSIZE, 2402436 f
FCFRAMECOUNT,1537
FC1FRAMESIZE,1564

R Copry of ari profia
B Feovqucfie

My [ gouments

FCOSIZE, 132

CONTAINERHEADERSIZE 88

FCFRAMEHEADERSIZE, 24 herie S lariooie E2 i
#LOCATION Flascims  |[Proiei 1" PROFLE) x o

FCHeader,00FFFFFF,00808000
CONTHeader,00FFFFFF,00004080
OBJO0,00FFFFFF,000040C0
CRC,00FFFFFF,00800080
PAYLOAD,00FFFFFF,00006060
#DEFINITIONS

1,BCB55757,SOFi Class1,00FFFFFF,00FF7F00
1,BCB53737,SOFn Class1,00,00FFFF00
1,BC95D5D5,EOFN,00,007F7F00
1,BCB5D5D5,EOFNnp,00,00FFFF00
1,BC957575,EOFt,00,007FFFO0
1,BCB57575,EOFtp,00,007FFFO0

4.3.4 Saving and Loading Raw Data

Raw Data can be saved to a binary file or loaded from a previously-saved file. This allows
viewing and analysis of previously-captured data. Saving Raw Data saves the entire capture
buffer (16Meg bytes) to disk file. This is often desirable when there is a particular feature or
problem in the captured data that the user wishes to save and then retrieve for analysis at a
later time. Since the entire capture buffer is saved, when this data is retrieved it is identical to
the original captured data.

To save Raw Data, in the File menu, select “Save”, then “Save RAW Buffer’. The data is

saved as binary data values. To Load Raw Data, in the File menu, select “Load”, then “Load
RAW Buffer”.

GRAV64_FCAV_ANA_USERSMANUAL.PDF 11/4/2008 PAGE 16




4.3.5 Selection of Trigger

Three options are provided for triggering: Trigger on Value, Trigger Immediate, and Trigger
on Error. These trigger options are described in the next three sections.

Note : Upon trigger a trigger out pulse will be sent out of the front panel Sync
connector via the differential Sync Out + and Sync Out — signals. This pulse is at the

start of the captured data and is approx. 1 uS in duration.

4.3.5.1 Trigger On Value

Figure 4.3.3 shows the predefined choices for Trigger on Value. Typically a SOFi would be

used to initiate data capture at the beginning of a new video frame.

@ Trigger On Yalue [JS0OFi Class3 RS

@ Trigger Immediate SOFi Class3

® Trigger On Error

. EOFnp
® Trigger On Extern:3

Status and Timing

Figure 4.3.3 Trigger Options

Source
© Optic
#® Copper

To trigger on a data string, select User Defined in the drop down menu, and type in an 8 digit

HEX number.

Mode

© Trigger On Yalue -

® Trigger Immediate

® Trigger On Error

4.3.5.2 Trigger Immediate

This type of trigger will not wait for any predefined vale and instead will capture data immediately.

This feature is useful when it is unknown what is on the link.

4.3.5.3 Trigger On Error

This type of trigger will on trigger the analyzer if an error is flagged. The four types of errors that

will cause this trigger are CRC, Disparity, Code Violation or Link sync.

Once the start button is pressed with this type of trigger, the analyzer will wait until an error
occurs before it triggers. This time frame could be indefinite and if the trigger never occurs
because of no errors, the Stop button must be pressed to stop the analyzer.
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4.3.5.4 Trigger on External

@ Trigger On Yalue [ESaL%]

® Trigger Inmediate

@ Trigger On Error

This type of trigger allows the analyzer to be triggered from an external source.

This external source is fed to the card via the Sync connector on the front panel. See the pin
descriptions for this connector below.

The analyzer is looking for a LO to HI transition and once it sees this signal, that trigger will be
initialized and data captured.

Note the electrical characteristics of this trigger signal. This is a differential input.

4.3.5.4.1 Sync Pulse Connector details

Pin Number Description

Sync Out Shield

Sync In Shield

Sync Out - (negative side of input sync pulse)

Sync In - (negative side of output pulse from trigger, approx 1uS long)

Sync Out + (positive side of input sync pulse)

OO |WIN|F

Sync In + (positive side of output pulse from trigger, approx 1uS long)

Pin definitions viewed from back panel of EFC PCI card

Mating Connector

In Line Plug

Manufacturer “Singatron”
Manufacturer P/N 62000-6P
Digikey P/N 275-1031-ND
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4.3.6 Selecting the Data Source

The FC-AV Analyzer card captures raw FC data via a FO850 link or a standard FCN copper
interface.

Source
Note: This data input is always a flow through to the TX port. Therefore & Optic
the analyzer can be inserted inline and will allow the flow of data without
interruption.

® Copper

The selection of this port is made with the radio buttons as shown below

4.3.7 Initiating a Data Capture

Once a trigger is selected, click once on the Start button. The gray button will
turn green, and the word Acquiring will be displayed. Typically, a data capture
will last less than 10 seconds. If a Trigger on Error is selected, the FCAV
Analyzer will wait indefinitely for an error. Pressing the Stop button will stop a
data capture. Stopping before the capture is completed can prevent a full data
trace from being captured

4.3.8 Link Status Check

After initiating a data capture, and before the data is captured, the FCAV Analyzer checks the
status of the fiber channel link. The check is done once, preceding the capture of data. The
definition of the link status bits are shown in Table 4.3.5 below.

- S-'t.:a;t;.l;..l-ndlcatu:é

Sync Link Green indicates that the serializer/encoder is able

to recognize (and synchronize on) 8b/10b codes. @ sync Link
SOFI/EOFt Pairs Indicates that a Start of Frame and End of Frame @ SOF/EOFt Pairs Det
Detect has been detected ' M
IDLE OS DET Green indicates that idle ordered sets have been

detected. ‘ Meg Running Disp
SOFi DETECT Green indicates that a series of SOFi ordered sets Latched

have been detected. * SOFi Detect
EOFt DETECT Green indicates that a series of EOFt ordered sets ® eor

| t Detect

have been detected. _
SOFn DETECT Green indicates that a series of SOFn ordered @ Ss0Fn Detect

sets have been detected. @ EOFn Detect
EOFn DETECT Green indicates that a series of EOFn ordered @ commapet

sets have been detected. &

— 8B/10B Status

COMMA DET Green indicates that K28.5 characters have been ‘ e Phedd

detected. Red indicates that no valid K28.5 : S

characters have been detected. @ Meg Running Disp
8b10b CODE Red indicates the detection of invalid 8B/10B - "

codes. Status Done
CRC Check Red indicates a FC Frame CRC error i
Neg Running Disparity |Red indicates a negative running disparity error

Table 4.3.5 Link Status

GRAV64_FCAV_ANA_USERSMANUAL.PDF 11/4/2008 PAGE 19



4.3.9 Captured Data Grid Format

The Raw Data headings are shown below with a small portion of the captured data. Each of the
headings are described below.

# of records in view 784
Y| #framezinvien 1 Espand View

: N + Frame #
GoTo Trigosr | ——  FEE A |urrsetu| _—
Tirne uS I 5 &
e
+.01
+.03
+.05
+.07
+.0%
+.11
+.13

=

1 A s L R

Status: OK
or Error

Time offset |[Hex Data

inns

Offset in
longwords

Data Type

Location Data Histogram
Frame:LWORD

Go To Frame#
or Offset #

Offset — indicates the offset in long words from the beginning of the data trace

Time — indicates time relative to the beginning of the data trace, or, relative to any point that the
user manually sets it to by clicking in the grid location.

Hex Data — Shown in 4-byte groups, with the least significant on the right hand side.

Data Type — indicates whether the Hex Data is data or a FCAV Ordered Set.

Status — Indicates if the data is OK or an error was detected.

Location — indicates location & function within a FC frame, such as a header, CRC...
Histogram — Shows relative position of a FC frame in the Grid, indicates the frame number, and
shows which frames are loaded into the grid. The default range of data is to load a frame above
and below the current frame. The amount of data in the grid can be expanded by clicking the

Expand View button.

Go To — Allows jumping to either a particular FC frame #, or an Offset number. Select Frame #
or Offset #, enter a number, and click Go To. The grid will then be populated with the desired data
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Indicates FC
Frame number
selected and
shown in data grid

4.3.10 Histogram

The Histogram is a graphical
representation of the all the data
captured. Since the data grid

displays less than a single FC
frame, the histogram indicate the
relative position of the data being
viewed in relation to the entire data
trace. In this example, a SOFi was
used as a

trigger. This area of data

Indicates which FC
frames are loaded
into data grid. To
expand the number
of frames, click
Expand View

represents a single
FC Container (also a

Errors will be
indicated by RED
dots in the Histogram

video frame) worth of
data. The gray area
represents idle

characters between

containers.

Gray area indicates
idle OS between FC
Containers

4.3.11 Container Statistics and Status

Once a container is selected by clicking in the Histogram, the container statistics will be updated.
The container size is all the data between the SOFi and the EOFt, and should be a fixed number
from container to container. The following is reported:
- Container Size in bytes
- Total FC Frames
- FC Frame 0 Size in bytes
- FC Frame 1 - N size in bytes
- SOFi Count - FC Frame CRC errors
- SOFn Count - 8B/10B disparity errors
- EOFn Count - Code errors
- EOFt Count - Synchronization errors

Status and Timing
Link Status
Counts and Status

Selected Container

Container Size [bytes]
Total FC Frames [ 1537
Objd Frame Size [bytes] m

FC1 Frame Size [bytes] m

Emor Flag Counts

SOFi Count ‘ CRC m
S50Fn Count m Dizparity m
EOFn Count m Code m
EOFt Count ‘ Sync m
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4.3.12 Container Image View Tab

The actual thumbnail of an image for the currently selected container can be viewed by clicking
on the “Image” Tab

This image is compressed to fit and is only for reference purposes only.
This image is actually decoded from the information in the PROFILE that is loaded so this
information must be correct for pixel packing and decoding.

As each container is selected from the Histogram, this image view will be updated.

Status and Timing Header Decode

Image iew

Image Size =1024 x 768 Scale is 3:1
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4.3.13 FC Frame Statistics and Status

The data in this section refer to the FC frame
indicated in the blue rectangle in the
Histogram, and again in the Selected FC FC Frame Size [bytes) [IBRLE]
Frame box. This section reports the size of
the selected frame, as well as:

Selected FC Frame —|

Ermror Flag [qur_tts

- SOFi Count - FC Frame CRC errors soFiCount Il cRC [ 0
- SOFn Count - 8B/10B disparity errors 50Fn Count M@ Disparity ]
- EOFn Count - Code errors —

- EOFt Count - Synchronization errors EDEn Count | Code NN

EOFt Count [INE  Sync [N

4.3.14 Video Frame Resolution and Timing

The Timing section calculates the Frame and Line Timing
video resolution, the line timing, and |_Ei
the container (video frame) rate. Timing

. . . Video Resolution
Video Resolution

The video resolution is provided in a @ Line Time (u5) : 20 724 o0 545

. . . L . . .
.profile file. The resolution from the
profile is compared against the Inter Video Line Idle 05 15 ik 311 e
calculated resolution 0n|y if the Inter FCFrame Idle D5 158 155 RH

“Enable Checking” is on. The

resolution is also O.'e”"ef' fr(_)rr,] the @ cContainerRate  ms [JEAEE .. [ITHTE 16.663
Container header if the “Obj0” check Min aw
box is on m Inter Cont. Idle 05 [ 41672 41670

FPS

Line Timing

The line timing is provided both in terms of microseconds, and idle counts between lines. The
line time in microseconds is determined by calculating the SOFn to EOFn time, and then adding
the min, max, and average times of the interline idle ordered sets. The second method of
determining line timing provides the count of idle ordered sets between lines since each FC frame
should be identical in length (except the first frame with the container header. The first FC
Frame is broken out, indicated by Obj0, in the example, 0 idle ordered sets were counted
because the data capture began in the middle of a container. The min, max, and average
number of idle ordered sets are given, and the number of lines used in the average is shown in
the lower right. A red oval shows that in this example, 1536 lines were averaged.

Container Rate

The container rate is also provided in terms of time and number Idle OS. The time is based on
SOFi to SOFi time, and the Idle OS number is a count. The FPS value is based on the average
frame rate. The number of containers used in the average in this example is 4, as shown in the
red oval.
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4.3.15 Header Inspection

Both FC Frame headers and container headers are
easy to inspect. By triggering a data capture on a
SOFi, the data grid will display FC Frame 0, which
contains a FC frame header, the container header, & Frame i

and Object 0 (ancillary data). The figure below shows © Difset # [
where each portion of the header can be found within
FC Frame 0.

SOFi mm

FC Frame Header

[ 40 [ 00 | Do [ 00 |

| 00 [ 0o | oo [ 68 |
| 00 | oo | oo |
[ 10 [ 00 | b0

Container Header L

Object O:

Ancillary Data

EOFn |
S
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4.3.16 Header Decode Tab

Selecting the Header Decode tab will display the Header for the current frame. On this tab, only
the FC Frame Header data is displayed. This view also shows a status message for the FC
Frame Header and Container Header as found in the current frame. The Container Header data
can also be displayed by pressing the “Show Container header” button. The format for the
Container Header data display can be changed by pressing the “Select Header Format” button
and selecting the desired format file. This selection is saved in the program initialization file.

A Header Decode Tab view is shown in the image below:

Statuz and Timing

FC Frame Header
R.CTL [44 Dest ID  [000000

cs_cTL foo Source ID [000000
TYPE [60 F.CTL  [oooooo

SEQ_ID D3 DF_CTL IDD SEQ_CHT |0000

0x_ID IDDDD R¥_ID IDDDD
Param IDDDDDDDD

FC Frame Header Status |FC Frame Header Data 1S found in grid

Container Header Status |E0ntainer Header Data IS found in grid

Show Container Headerl Select Header Format

Header Format File |AIF|I MNCE18.hid
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The Container Header data can also be displayed by pressing the “Show Container header”
button. This will display the FC Frame Header, Container Header, and Object 0 Ancillary data for
the current frame, as the image below illustrates:

| il Header

aooooon
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4.3.17 Searching Data

Once data has been captured, is easily examined using the two search methods, Search for
VALUE, or Search for ERROR. Once a search parameter is selected, clicking the next or
previous button will jump the data grid to where the parameter is, and reload the grid if needed. If
a search is initiated and the parameter does not exist in the data trace, a dialog box wil open and

indicate that the parameter doesn’t exist.

Search on Value
A drop down menu provides an extensive
list of search options that are optimized
for evaluating FCAV containers and FC
frames.
The search options include:
- SOFiClass 1

SOFn Class 1

EOFN

EOFnp

EOFt

EOFtp

EOFn or EOFnp

EOFt or EOFtp

IDLE OS

OS Unknown

User Defined

If User Defined is selected, then an 8
digit value is entered, in HEX, into the
the input field. A search is initiated by
indicating Prev (for previous), or Next.

Search on Error
Three options are provided for finding
errors within a data trace

Error Flags

FC Frames

Inter Frame

Search
@ Value

Uger Defined

00000000 |5 Tr
‘
EOFtp
EOQFn or EOFnp

‘EOFt or EOFtp ecords in view §28
bl PRI E xpand Yigw |

[S0Fn Class1

S0Fn Class1
EOFn

EOFnp

EOFt

® Error

Search
Defined

fRTET T User Defined - 1‘
00FF 00FF| [ZHL
[ RS Error Flags = iy

Search

[ RIETT User Defined - | T
s O

Ilzer Defined

Error Flags

Searching for an Error Flag will find an occurrence of any of the 4 types of error flags:
FC Frame CRC, 8B/10B Disparity, 8B/10B Code, and Receiver Synchronization. These errors

are discussed in section 4.4.4.

FC Frame error indicates erroneous ordered sets between a SOFn/EOFn pair, which should

contain only data.

An Inter Frame error indicates that something other than an idle OS occurs between an EOFt and

the next SOFi.
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4.3.18 Saving Data View to File

Data in the grid can be saved as a comma delimited file. The entire data
buffer isn’t saved, just the frames indicated by the green numbers on the
Histogram. The data is saved by selecting the File drop down menu,
selecting Save Data View, and then entering a file name. The data will be
saved as a .CSV (comma separated values) type file and can be imported
into Excel for viewing and formatting.

All of the data can be saved to a .DAT file for later loading.

Select the File menu and Under Save, choose “Save Raw Buffer”.

To later reload any save .DAT file, first make sure you have the correct PROFILE loaded the
under File menu choose Load “Load Raw Buffer”

4.3.19 Data View File Description

The Data View file is a CSV (comma separated value) file containing the frames saved in the
Data View. The file has a 5 line header containing the location of the file, the Profile, the number
of records, and a date/time stamp. After the header there are 6 columns for OFFSET, TIME (in
microseconds), the HEX DATA, DATA TYPE, STATUS and LOCATION. The data in these
columns is the same content as in the GRAVity Analyzer GUI Data View.

The image below shows part of a Data View file:

B ot Facel- el om
DEEa &R inaTo-c R AU DA = - 0| s =Bzl
T | o
O PR S Pt R X S G, = AL Y Sl S S S - i =
1| (v Rmer Tep wdor s FCAY R Dy Aoz
2 | D M § & - COCCPTR ! S0nn 1y BeS e GRS s i o snDeTacsstl. o
5 |Poll s rame |3eced = 831 SR CFLE
& | Tl wahor of raconl s ghood = T
B 221706 15 [E
E |CFFZET NVEWE HZX WK CATATIPE ETRTUS LCCATION
AL EESS 0 BT S0 (aes) OW Sl (hoe
E| 1 02 490000T Cis = FC Heakr [t
] H [ ] O Cam e 3 Fi Huada D2
1| 3006 G0N Caa (n Fi; Hoador (ed
A1) [} N°7 AW Caa n el eaterTtd
15 E a3 OCrs O FC Handw [0
1z =, ur ULrw ik Fi Hamdar L
1" Tan e D o Ol 07
L F LN ] Diwa [n, CEEeD 08
Q| Hoawm NFra A Pkpchon
(F4) (M im O Ca = Ctpch a1
1= 1 (L U L L Ltmcd UN
iz {3 da 40§ [= Olpel 0142
| (U =L -] ok % .00 R H
Ealll L[} ns= IMCox L mpch N4l
5| i a4 B Lo = Dtpcd a1
&= 1= [TE} ULrw i tmell U1
ot " [} ARO0 [ [ 3 Clpe 0 01
=] (H () niea [n 3 Ceierd 0
=| 5N @ Fas i pEpen i
x| = a OCry L= Ctpc 022
& A W2 CRRALIE Lew i kol U
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B Hoonw NFra G L]
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= | % ATd CTTOMWT Cra 4 hpch T
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4.4 Using the GRAVity FCAV Analyzer for Troubleshooting

The GRAVity FCAV Analyzer can help find and diagnose a number of common errors that occur
during the development phase of FCAV systems.

441 FC Frame and FCAV Container Structure

A Fiber Channel frame has the following elements: a SOFi or SOFn, a FC Header, the Payload or
Container Header and Ancillary Data, a CRC, and an EOFn or EOFt. Figure 4.4.1 (below) shows
how these elements are easily identified with the GRAVity FCAV Analyzer.

A data trace that was captured with a SOFi trigger as shown below.

H# of records in view 784

# frames inview 1 EwpandYiew |

{* Frame #
C Offset # | 1 Gota |

SOFi

FC Frame Header

Payload or
Container
Header

Object 0

CRC

EOFn

Figure 4.4.1 Data Trace Showing Container and Frame Structure

Complete containers should also have a matched SOFI/EOFt pair (one per container), as well as
SOFN/EOFN matched pairs (one per FC Frame). The example shown in Figure 4.4.2 gives
insight into how the FCAV Analyzer helps to easily determine frame and container structure
issues. The Histogram indicates that FC Frame 139 is being evaluated, and by inspection, it is
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clear that a full container is not present because the length of the data before the gray area
indicating interframe idle OS isn’'t the same length as the full containers below. Inspecting the
status shows the wrong number of bytes in the container, wrong number of frames, a SOFI/EOFt
mismatch, wrong video resolution, but correct frame structure, line timing, and container timing in
the balance of the data trace. Conclusion: The FC Frame and Container structures are fine, as
well as the line and container timing, but a full container wasn’t received.
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The Following Errors will only show up if the “Enable Checking” check boxes are checked for both
the Timing and the Counts and Stats areas

139
Histogram shows

full container not

present due length

of data

Container Size Low

Incorrect number of frames

No Container Header

SOFI/EOFt pair mismatch
indicates a complete
container wasn't received

Frame 139 is proper size,
framed by an SOFn/EOFn
pair, with no Error flags set

Video Resolution wrong — no data
from container header, but
calculated resolution at 1024 x 184
shows that complete video lines
are being received, but the full
container wasn't received

Line timing and container rate are
correct.

Despite an incomplete container at the beginning,
four complete containers were received
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4.4.2 Video Line Timing

Precise video line timing can be important for maintaining synchronization with a display, or
preventing video receiver FIFO
problems. The FCAV Analyzer @ Line Time (us) us
captures and calculates the minimum, Inter Video Line Idle 05
maximum, and average line times over Inter FCFrame Idle DS

the selected FCAV container. A
container is selected by clicking in the
histogram.

An individual line time can be determined by searching for an SOFn,
clicking in the time stamp (leftmost column) to set the time to O relative
to the SOFnN, then searching for the next EOFn and looking at the time
code. For formats that use two FC frames per video line, it is
necessary to go to the second EOFn. The time of the line can be read
directly from the time code of the second EOFn.

4.4.3 Video Frame Timing

The timing of a video frame is

casily verified by checking the @ Container Rate i 15 ssT/ 15557 S ﬁ
container rate in FPS or ms. ‘ Counted Idle 05 IR = IENEE | e

FPS

4.4.4 Link Synchronization and Errors
When a data capture is initiated by selecting a trigger and clicking the p7> tus Indicatars

start button, the fiber channel serial link is checked prior to capturing & SyncLink

data. The 10 Status Indicator lights display the results of the status @ SOF/EOFt Paits Det
check. These lights indicate the status of the link BEFORE the data is “ o s
captured, and provide a valuable snapshot of the link. eSS

10 Status
Indicators

Latched

@ soFiDetect
@ tortpetect
*. 50Fn Detect
’- EOFn Detect

*- Comma Det
@ 88108 Status
@ CRC Check

Status one
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Four error indicators are captured as part of the data trace. The four error flags indicate the health
of each FC Frame, and a receiver’s ability to capture the incoming data. The four error flags are:
Sync, Code, Disparity, and CRC. They are described below.

§ Sync —indicates the receiver can't distinguish and
capture the incoming bit stream, indicating a = Selected FC Frame [ ————
mismatched frequency or that 8B/10B packets aren't FC Frame Size (bytes) [IINSTEEY
present. This is the lowest level link check.

Error Flag-© L.uum..

been received. R I

§ Code — indicates that an invalid 88/10B code has sorycont I “Che
. S0Fn Count ‘ Dl.palll_v
EOFt Count m Syac

§ Disparity —indicates the incorrect disparity of a 10B
code.

§ CRC - indicates that the CRC embedded at the end of a FC frame does not match the
CRC calculated by the analyzer over the FC Frame. A CRC error can indicate bit errors
during transmission or reception. A CRC error always refers to the CRC in the FCFrame
above the CRC errors in the Raw data.

As shown below, the CRC errors corresponds with the CRC in the previous FCFrame

Io3aT 438 .

33 Paylasd 3350

SIS +00
zoaw #3030
2040 +380 . d

Zmal 430 .41
Sz +30 .
F1.E8 430 .45
Zhda +34 . 47
2042 +3 . 48
2048 +M. 51
20dT +14. 51
2048 +30. 88
2hd% +34. 88
2080 +304 .54
A L] | +34.8

2082 +34 .82
2052 +3 . 64
2084 +M . 6
208K +10 . 64
Z0EE +M.7

2087 +34. 72
A L] +34. 73
o L] +34.78
20 +3. 77
201 +3. T4
22 +3 . 81

L] +34 . 1
204 +30 . A%
208 +34 .87
e +34 . A
EL +34.5

EL L) +34 . 52
EL ] +3 . B4
2070 +3 . 0

2071 +34 . 54
2092 +34

2074 +34 . b2
2074 +34 . b
2078 +34 . 08
2074 +3.07

GRAV64_FCAV_ANA_USERSMANUAL.PDF 11/4/2008 PAGE 33



4.45 Trigger Faults

This application has features to check the integrity of the RAW data. Specifically, the program
can check the unused bits b0, b1, and b2 in the Status Word. When these bits are found to be
set, this usually indicates a Trigger Fault in the RAW data. To enable detection of this error,
check the checkbox labeled “Detect Status Word Errors” in the Trigger area of the main screen.
If this checkbox is selected and such an error is detected, the user should re-trigger and capture
new data.

Mode — —

D Trigger On Value [ERGIo
Enables error checking of @ Trigger Immediate lz233i B
Status Word to detect

Trigger Faults ® Trigger On Error

If a Status Word Trigger Fault error is detected, the following error message will be displayed:

GRAYityAnalyzer ) 5!

A Status Word ERROR was detected in data at word offset 719
in the raw data. Raw data buffer corruption is is suspected
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4.5 Advanced Diagnostics

Disclaimer: The diagnostic functions are provided for factory test, and verification.
Advanced users may find some of the functions helpful for system verification, but it is possible to
override safety features of the application that can result in corrupted data, and system lock up.
The grayed out section of the menu box should not be accessed unless specifically instructed by
a factory representative.

To open the Advanced Diagnostics dialog box, got to the Advanced drop down menu, and select
H/W Viewer

Read/Write

Sets action of Go button \

tanual Control and Diagnostics

Memory Address e
(See Table) e s
Byte Addrezs [HE=]
oooooooo
Data Value HDDDDDDDD
Data HEX)
Executes operation p Go
# of D'WORDS ta Read
Diata Wiew
View Status Registers p FLOR | PO RA|

/
Cioe

= For Factory Use Only

View Control Registers /

The diagnostics menu can be used to view the contents of the PLD status registers and to view
the content of the Ping and Pong image stores or to change pixel values in memory.

The PLD R button is used to retrieve the contents of status registers in the PLD and the PLD R/W
is used to retrieve content of the PLD control registers.
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Ping and Pong memory contents can be observed using the following steps:

1.

2.

3.

4.

Enter the base address (In hex) in the top most entry box
Check the Read radio button
Enter the number of Double Words to read

Click the GO button

The memory contents will be displayed in the view port.

Ping and Pong memory, header and pixel data, can be modified using the following steps:

5.

6.

7.

8.

Enter the base address (In hex) in the top most entry box
Check the Write radio button
Enter the new value (In hex) in the bottom most entry box

Click the GO button

The memory contents will be displayed in the view port. Note that when a write command is
executed the number of displayed DWORDS is automatically set to 1.

4.6 Loop Through (Line Spy)

The GRAVity FCAV Analyzer has a loop through feature. The incoming data stream will be
transmitted out exactly as received, with the exception of CRC errors. If a FC Frame is received
with a CRC error, a correct CRC will be inserted in the transmitted frame. This feature is always
active when the analyzer is running and when the analyzer triggers, the last container is sent
through the line spy. Therefore a receiving card will on the line spy will always capture the last
container.

This is applicable to both the Optic and Copper connectors.
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5 Fibre Channel Frame Format and Ordered Sets

The Fibre Channel transport layer is comprised of frames as defined below.

The basic unit of transport for video and header data will be FC frame. Each FC frame has
the structure shown below (and as described in the referenced FC-PH specification).

Word Identifier Byte 0 Byte 1 Byte 2 Byte 3
XX Idle word K28.5 D21.4 D21.5 D21.5
XX Idle word K28.5 D21.4 D21.5 D21.5

0 SOF, K28.5 D21.5 D23.x D23.x
1 Frame Header FC Frame FC Frame FC Frame FC Frame
R CTLD ID Header byte Header byte Header byte Header byte
2 Frame Header FC Frame FC Frame FC Frame FC Frame
CS _CTL S ID | Header byte Header byte Header byte Header byte
3 Frame Header FC Frame 0000 x000 FC Frame FC Frame
Type F CTL | Header byte (Bit 19) Header byte Header byte
4 Frame Header FC Frame FC Frame 0000 0000 0000 0000
Header byte | Header byte (SEQ_CNT) (SEQ_CNT)
5 Frame Header FC Frame FC Frame FC Frame FC Frame
Header byte Header byte Header byte Header byte
6 Frame Header FC Frame FC Frame FC Frame FC Frame
Header byte Header byte Header byte Header byte

7 to N* Payload Data Data Data Data
N+1 CRC Data Data Data Data
N+2 EOF 4 K28.5 D21.x D21.x D21.x
XX Idle word K28.5 D21.4 D21.5 D21.5

Table 5.0a Fibre Channel Frame Definition

The 24 FC Frame header bytes originate from header files loaded via GRAV_FCAV. All
fields can be set by the user and may be defined differently than described in FC-PH.
However, Gravity FC-AV will automatically update the sequence count and the end sequence
bit as described below.

SEQ_CNT

The Sequence Count is used as defined in FC-PH and is incremented by one

LSB for each consecutive FC frame of the FC-AV data sequence.

END_SEQ

The End Sequence bit (Word 3, bit 19) is set to logic 1 for the last FC frame of a
data sequence (FC-AV container), and set to logic O for all other frames of the

sequence.
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5.1 Idle Words

Idle ordered sets, K28.5, D21.4, D21.5, D21.5, are transmitted between FC frames and their
number can be adjusted to change the overall timing of the video field rate (or FC-AV
container rate).

When receiving, the Gravity FC-AV requires a minimum of six Idle ordered sets between
each Fibre Channel frame.

When transmitting, the number of Idle ordered sets between FC frames can be varied to
adjust the video frame time.

The Gravity FC-AV automatically pads the Idle OS after the last FC frame in a sequence,
such that the required video frame rate (required by the profile) is achieved. Users may set

the minimum number of Idle OS between all other frames by writing to a PLD control register.
(See EFC API User’s Manual)

5.2 Start of Frame

The first frame of an FC-AV container transfer sequence uses the Start of Frame Initiate
Class 1 SOF;; ordered set (K28.5, D21.5, D23.2, D23.2). Subsequent frames of the FC-AV
container sequence use the Start of Frame Normal Class 1 SOF,; ordered set (K28.5, D21.5,
D23.1, D23.1).

5.3 Data Payloads

The first frame of an FC-AV container data sequence contains the container header and
Object 0 ancillary data as its data payload.

Subsequent frames of the FC-AV container sequence contain the Object 2 video pixel data.
5.4 Cyclic Redundancy Check (CRC)

All data frames include a 4 byte CRC using the following 32-bit polynomial:

X32+x26+x23+x22+x16+X12+Xll+x10+x8+x7+x5+x4+x2+X+1

5.5 End of Frame

All frames except the last frame of an FC-AV container data transfer sequence use the End
of Frame Normal EOF, ordered set (beginning RD Negative - K28.5, D21.4, D21.6, D21.6 or
beginning RD Positive - K28.5, D21.5, D21.6, D21.6).

The last frame of an FC-AV container data transfer sequence uses the End of Frame

Terminate EOF,ordered set (beginning RD Negative - K28.5, D21.4, D21.3, D21.3 or
beginning RD Positive - K28.5, D21.5, D21.3, D21.3).
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6 Fibre Channel Containers

Gravity FC-AV cards adhere to the FC-AV container system of transport as described in
Clause 5 of the standard.

A container is simply the set of Fibre Channel frames used to transport a single video frame.

For uncompressed progressive scanned video, only two objects are required: Object 0, which
contains ancillary data, and Object 2 that carries the video payload. Object 1, by definition, is

restricted to Audio and is not typically used.

6.1 FCframeO

In all video profiles, the container header and Object 0 are in a single Fibre Channel frame.
This frame is the first frame of the sequence and begins with an SOFi (rather than SOFn). All
subsequent frames (Object 2) carry video payload.

The Fibre Channel frame 0 is comprised of 32 long words (128 bytes) as follows:

FC Frame header 6 Lwords (24 bytes)
FC-AV Container Header 22 Lwords (88 Bytes)
Object 0: Ancillary Data 4 Lwords (16 bytes)
Total 32 Lwords (128 bytes)

The FC frame header is that same as that defined in section 5. The container header and
ancillary data are described in the “FC-AV Container Header” section below.

GRAV64_FCAV_ANA_USERSMANUAL.PDF 11/4/2008 PAGE 39



6.2 FC-AV Container Header

Gravity FC-AV cards allow users to adhere to the standard definition of the Container Header
(as shown in table 6.2) or, since Gravity cards use text based header files, part or all of these

fields may be user defined.

Word Identifier Byte 0 Byte 1 Byte 2 Byte 3
0 Container Count (MSB) (LSB)
1 Clip ID (MSB) (LSB)
2 Container Time (MSB)
Stamp
3 Container Time (LSB)
Stamp
4 Transmission Type (Video (Transmission (Reserved) (Reserved)
Frame Rate) Rate)
5 Container Type (Mode) (Number of (Reserved) (Size of Ext.
Objects) Header)
6 Object 0 Class (Type) (Link Pointer) (SPDV (SPDV
Index) Index)
7 Object 0 Size (MSB) (LSB)
8 Object 0 Offset (MSB) (LSB)
9 Object 0 Object Type Defined | Type Defined | Type Defined | Type Defined
Type Defined
10 Object 1 Class (Type) (Link Pointer) (SPDV (SPDV
Index) Index)
11 Object 1 Size (MSB) (LSB)
12 Object 1 Offset (MSB) (LSB)
13 Object 1 Object (Type) (Link Pointer) (SPDV (SPDV
Type Defined Index) Index)
14 Object 2 Class (Type) (Link Pointer) (SPDV (SPDV
Index) Index)
15 Object 2 Size (MSB) (LSB)
16 Object 2 Offset (MSB) (LSB)
17 Object 2 Object Type Defined | Type Defined | Type Defined | Type Defined
Type Defined
18 Object 3 Class (Type) (Link Pointer) (SPDV (SPDV
Index) Index)
19 Object 3 Size (MSB) (LSB)
20 Object 3 Offset (MSB) (LSB)
21 Object 3 Object Type Defined | Type Defined | Type Defined | Type Defined

Type Defined
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6.3 FC-AV Object 0: Ancillary Data

Also included in the Object 0 FC frame are 24 bytes of Ancillary Data (as shown in table 6.3).
Since the Gravity card uses text based header files, part or all of these fields may be user
defined.

Word Identifier
0 Ancillary Data
1 Ancillary Data
2 User Defined Data
3 User Defined Data

Table 6.3 Object 0 Ancillary data

6.4 FC-AV Object 2 Video Data

In all video profiles, container Object 2 is comprised of a set of Fibre Channel frames. These
frames begin with SOFn and can carry up to 2112 bytes video of video payload per FC
frame. The exact number of bytes per FC frame and the total number of FC frames, depends

on the video profiles.

Gravity FC-AV cards, using the standard firmware, support video profiles as described in
Section 7. Supported video profiles insert one half of a video line using three bytes per pixel
in each FC payload frame.
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